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Visualisation 101
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Learning outcomes

Familiarise yourself with the Mercury interface

Learn the basic options to visualise small molecule crystal
structures

Learn how to visualise the packing of a structure effectively

Learn how to create high resolution publication ready images of
your structures
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Mercury - Structure visualisation

With Mercury you can:

* Explore over 1T million crystal structures,
molecular conformations,
crystallographic planes and simulated
mMorphologies

« Generate high quality structural images
for effective scientific communication

« Output model files for 3D printing

« Analyse geometries, interactions and
the packing inside structures
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The basics of navigating
Mercury

advancing structural science



Mercury Overview

2
@
@ AABHTZ (P-1) - Mercury — O X
File Edit Selection Display Calculate CSD-Community C5D-Core  C5D-Materials  C5D-Discovery  C5D Python AP1 Help
Picking Mode: | Pick Atoms ~ | Clear Measurements IE‘ p @ |:| Show Labels for | All atoms with  Atom Label
Style: Balland Stick ™ Colour: | by Element or Suppression ™ Manage Styles... |Work b Atom selections: bed
l:‘ Animate. .. Default view: b v a b c a* b* & - ¥+ y- y+ z- z+ %90 x+90 y-90 y+90 z90 z+90 & > L T zoom- zoom+ Select by SMARTS:|[c]
Structure Navigator & X
AABHTZ =
Crystal Structures Spacegroup N
AABHTZ P-1
AACANITO0 P21/c
AACANIT1 P21/c
AACFAZ Pbcn
AACFAZ10 Pbcn
AACMAL P21/c
AACMHX10 Pbca
AACRHA Pncm
AACRHC P-1
AACRUB Cc
AACRUBO1 C2/c
AADAMC P21/c
AADMPY P-1
AADMPY10  P-1
AADRIB P21
AAGAGGT10  P212121
Display Options g X AAGGAG10 P21 &
Display Options
<< >
[ pading [ ] Short Contact < (sum of vdW radii) Contacts... show hydrogens || Depth cue -
I:‘ Asymmetric Unit I:‘ H_Bond Default definition I:‘ Show cell axes I:‘ Z-Clipping
l:‘ Auto centre More Info v |:| Label atoms Stereo l:‘ Multiple Structures
Reset Powder... Structures...

Press the left mouse button and move the mouse to rotate the structure




| Structure Navigator F X ™

1 | @
CSD Refcodes reminder T 1S

What is AABHTZ?
« A CSD Refcode

« A database reference code
« Containing 6-8 characters
« Used to identify entries in the CSD

CSD Refcode -
AABHTZ

Refcode families

* The same substances are assighed the same 6 letter code plus an additional 2 numbers
* Polymorphs

« New determinations or re-refinements of the same substance
- Determinations at different temperatures/pressures
Stereoisomers or different solvates, co-crystals, etc are assigned different refcode families

CCDC

Some more recognisable refcodes: KITTEN, BATMAN, BADBOY, CGAUTAM, GLYCIN




The basics

» Left mouse button and move — allows you
to rotate structure

« Middle Mouse button and move — allows
you to move structure

* Right mouse button and move — allows
you to zoom in and out of structure
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The basics

With the keyboard:

Shift +

+ % | 7‘ - 6 ; - ‘. . ,ﬁ
% “anta SO CSD Refcode: GIMXUY
t‘ :
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Right mouse click

Near a molecule

Selection

Styles

Colours
Labels
Show/Hide

Contacts

Delete this Molecule
Rotation Centre

IsoStar Interactions Check...

e

Measure
Clear Measurements

Packing

Selection
Styles
Colours
Labels
Show/Hide

Contacts
Picking Mode
View

Rotation Centre

New

Draw Backdrop

Display Options...

o
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File Edit Selection Display Calculate

CSD-Community CSD-System  CSD-Materials

Picking Mode: | Pick Atomr Styles p easurements @ f:) @3 [] Show Labels for All atoms
Style: | Capped Sticks = Manage Styles... Work - | - Atom selections:
: Labels
[] Animate... De b* ¢ | % w+ y y+ z- z+ %00 x+90 y-90 y+90
Colours L4 . :
»" Display Options
Show/Hide L4

Mare Information g

Symmetry Elements...

Voids...

Manage Styles...

Wiew along r

Dial box...

Splash screen

Toolbars

Display Options

Display

Graph Sets
Intermuolecular Potentials
Searches

Post Search Options

Display Options... I

Structure Mavigator

Picking Toolbar

Labels

Display

Style Manager Toolbar
Atom Selection Toolbar
Select by SMARTS
Animation Toolbar

Crystal Orientation Operations

LA LR LKA X

Alignment and Crientation Operations

Options

Default definition

Feset

< (sum of vdW radii)

Show hydrogens [_| Depth cue
[ ] show cellaxes [ _] Z-Clipping
] Label atoms Stereo

Contacts...

More Info ~

Powder...

CSD-Discovery CSD Python API

Help
with Atom Label

z-90 z+90 < =+ L T zoom- il

Select w SMARTS: >

Structure Navigator g X
Find
Crystal Structures Spacegroup ~
AABHTZ  P-1
AACANITO P21/c
AACANITT P21/c
AACFAZ Pbcn
AACFAZ10 Pben
AACMAL  P21/c
AACMHX10 Pbca
AACRHA  Pncm
AACRHC  P-1
AACRUB Cc
AACRUBOT C2/c
AADAMC  P21/c
AADMPY  P-1
AADMPY10 P-1
AADRIB P21
AAGAGGT0 P212121
AAGGAGT0 P21
AALCFE P21/c
AALPRO P21/c
AAMAND  P212121
AAMTCO P
AAMTCO10 P-1
AAMTXP  P21/n
AANHOX  Pna2l
AANHOXO01T Pnall
& x AANOPM P21
AAPUNI P21/a W
<= ==
Tree View

[] multiple Structures

Structures...

Handy tips:
« Recovering
Toolbars
¢ Resetting

view
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Using your own file e

* File > Open —to open one of your own files for example a CIF

Auto Edit Manual Edit

e Edit > Auto Edit Structure to assign bond types

Guess bond types
. . SF\
 File > Auto Edit Structure on Load to automate ® Only bonds with urknown types
& AABHTZ (P-1) - Mercury
Edit Selecti Displ Calculate CSD-C
File Edit Selection Display Calculate = ~eection “isplay aadlate o
I 5 o0 I Undo: Packing off Ctrl+Z ) o oe S Patabase
en... rl+ .
P Redo: Not Available Ctrl+Y Aromatic bonds
Recent Files » Delocalised Bonds
Copy Image to Clipboard Ctrl+C
Sketch Molecule... Ctrl+K
Edit Structure...

Auto Edit Structure on Load Auto Edit Structure...

Normalise Hydrogens...

Save As... Ctrl+S dd missing H atoms
POV-Ray Image Polymer Expansion...
Print in 3D... Transform Molecules...

Apply Close

Change Spacegroup Setting...

Exit Ctrl+Q




Styles and colours options
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Changing display - Style

Display Calculate CSD-Community CSD-System CSD-M

File Edit Selection Display Calculate C

_Picking Mode: Pick Atoms

Style:

Spacefill

. |E=:|I::|L

Styles 4 I Wireframe

Labels 4 Stick

Colours 4 Ball and stick

Show/Hide 4 Spacefill

More Information * Ellipsoid
Polyhedral

Symmetry Elements...

Voids Stick settings...

Display Options...
Manage Styles...

View along
Dial box...

v Splash screen

Toolbars

Ball and Stick settings...

Spacefill settings...
Ellipsoid settings...
Polyhedral settings...

Contact settings...

Measurement settings...

Selerted atnms

Animate...

r: by Element

ault view: b ~




Thermal ellipsoids

* Anisotropic Displacement Parameters

* Only available for CSD structures with
ADPs

* Indicate thermal vibrations of atoms

 Size of ellipsoid is scaled

« Usually to probability of finding 50% of
electron dem5|ty (47] Ellipsoid Display Options

F
-

% Probability level (%) |50

Display options

Draw principal elipses, in colour: | 1N

il
|:| Draw hydrogens as fixed-size spheres, of radius (8):  0.30

Draw MNon-Positive-Definite atoms as cubes

Display Calculate CSD-Community CSD-Core CSD-Mate

Styles
Labels
Colours
Show/Hide

More Information

Symmetry Elements...
Voids...

Display Options...
Manage Styles...

View along

14

LORBAW

4

4

»

4

-

CSD Refcode: /.

Wireframe
Stick

Ball and stick
Spacefill
Ellipsoid
Polyhedral

Stick settings...
Ball and Stick settings...
Spacefill settings...

Ellipsoid settings...

Polyhedral settings...




Display Calculate CSD-Community CSD-Core CSD-Mate

Styles

Polyhedral display abel

Colours
Show/Hide

* Visualise metal-organic structures
using polyhedral representations for
the metal-organic coordination centres.

More Information

Symmetry Elements...

Display Options...
Manage Styles...

View along

Voids...
¢« Central Elements - atoms around which
polyhedra are centred
* Ligand Elements - neighbouring atoms
which create the corners of the polyhedron ~
() Polyhedral Display Options X
Connectivity options
D Include Pi bonds
Central Elements... Ligand Elements...

Display options
Draw edges

Opacity: IlI

Defaults Close

r

2

3

3

-

Wireframe
Stick

Ball and stick
Spacefill
Ellipsoid
Polyhedral

Stick settings...

Ball and Stick settings...
Spacefill settings...
Ellipsoid settings...

Polyhedral settings...




Changing display - Colours

Display Calculate C5D-Community  C5D-5ystemn C5D-Matenals

v

Styles »
Labels »
Colours 2 Atoms...
Show/Hide 4 Bonds...
Centroids...
More Information » snirelds
Planes...
Symmetry Elements...
Contacts...

Voids...

Elernent colours...

Display Opticns...
Symmetry Equivalence colours...

Manage Styles...

Labels...
View along »

Background settings...
Dial box...

CSD Refcode: AACRUB

Splash screen

File Edit Selection Display Calculate CSD-Community
Picking Mode: Pick Atoms * | Clear b

Style: Ball and Stick |~ Colour: |by Flement ~
. by Element |

]| Animate..

by Atomic displacement

by Symmetry operation

by Gasteiger charge

by Partial charge

by Element or Suppression ]

—

Default view




Changing display - Colours

@ CAKFAW (P21/n) - Mercury
File Edit Selection Display Calculate CSD-Community CSD-System CSD-M

Picking Mode: Pick Atoms v | Clear Measurements @ ,O (E

Style: Ball and Stick

El Animate...

 Colour: by Element or Suppression ~ = [Manage Styles... Card:

Default view: b villa b c a* b* ¢* X- X+ y- )

be suppressed.

CSD Refcodes: CAKFAW and PIYDEI

Disordered structures report two sets of
atomic coordinates: major and minor sites.
N Most cases the atoms of the minor site will

CCDC



Changing background colour

@ AABHTZ (P-1) - Mercury

File Edit Selection Display Calculate CSD-Con

Picking Mode: Pick At
Style: Polyhedral
D Animate... L

Styles
Labels
Colours
Show/Hide

More Information

Symmetry Elements...
Voids...

Display Options...
Manage Styles...

View along

Dial box...

Splash screen

Toolbars

r

3

4

0 Select Color

Basic colors

Pick Screen Color

Custom colors

(] Display Options

Background
Depth Cueing
Labels
Lighting

Line

Stereo
Z-Clipping
Box-Clipping

I I
I I

Add to Custom Colors

(®) Single colour

Hue: |D :| Red: |255 :‘

Sat: |D :| Green: |255 :‘

val: 255 3| Blue: [255 3

HTML: |#ffff |

() Gradient

Defaults

Close
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More advanced display options G

Display Calculate C5D-Comn

Styles

Labels
Colours

Show/Hide

Pare Information

Symmetry Elements...

Vaids...

b

b

I Display Options...

Manage Styles...

View along

Dial box...

Background
Depth Cueing
Labels
Lighting

Line

Stereo
7-Clipping
Box-Clipping

Light 1 Light 2 Light 3 Light 4

Diffuse colour: Specular colour:

Enabled

Position: x: 1]y: 1|z: 1

Ambient Light
Enabled Diffuse ambient colour: | 1=

Defaults

Close




Mahnage styles G

» Pre-saved combinations of settings (styles, styles options, colours: .
background colour, ...) YAy e

File Edit Selection Display Calculate CSD-Community CSD-System CSD-Materials CSD-Discovery CSD Python
Picking Mode: | Pick Atoms v | Clear Measurements @ g % [ ] Show Labels for All atoms
Style: |Ball and Stick ~ (Colour: by Element

Manage Styles... |Publication ~

[ ] Animate..  Default view: b v  a b c a* L 90 )
oo Work personalised

Presentation options
ORTEP
3D Print
Work 2
Card

ore-saved A=

options

CCDC



Display packing
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] Packing and Slicing

Packing

Show cell axes
Label cell axes

Y
Y

Reset

+

0.5

Display Options
Display
[v/| Packing |
|:| Asymmetric Unit

|:| Auto cenfre

Reset T

C50-Materials

C5D-Discovery S0 Python AP

\[b Q @} I:‘ Show Labels for | All atoms

@ AABHTZ (P-1) - Mercury
File Edit Selection Display = Calculate C50-Community  C5D-Core
Picking Mode: Expand Contacts C EntrDidS... rements
Style: | Ball and Stick » Colour: PIEHES...

Animate. .. Default view . .. X+ y-
L] Packing/Slicing...

Contacts...
Molecular Shell...
Graph Sets...

ndude atoms

O ... that Fit
@ .« in molecules whose Centroids fit
O ... in molecules where Any atom fits

... in molecules where All atoms fit

Reset
button:
a friend!

|:| Short Contact < (sum of vd

H-Bond

Click on a red contact to see the whole molecule

Manage Styles... |Publication

¥+ - z+

Contacts...

Mare Info -

Poweder...

X-90 x+90 y-90 y+90 z-90 z+90

b Atom selections:

Options
Show hydrogens D Depth cue

I W | Show cell axes ID Z-Clipping
I:‘ Label atoms

Stereo

= = J T zoom+

with | Atom Label

- O
Select by SMARTS: »

Structure Mavigator g X
AABHTZ | res
Crystal Structures ™

ABRHTE P

Al NI P

ARLANITT P

ANCEAL Phon

Al AT b

A BASL P

Al MHXTD  Phoa

ASLRHA P

ASCHHC P-1

AL e

AACRUBDT  Ca%

A8 DARMIC P

A LAY -1

AAMAPYID P

Al iRIH P

AAGAGID P22 .

AAGGAGIO P21 W
< >

<< =5

Tree View

|:| Multiple Structures

Structures...




Other display options

Display Options
Display

Options

Packing

Asymmetric Unit

|:| Auto centre

Reset

D Short ... < (sum of vdW radii)
D H-Bon... Default definition

Structure Information...

Chemical Diagram...

Atom List...
Bond List...
Contacts List...

Centroids List...
Planes List...

Symmetry Operator

Distances List...

Angles List...

Torsions List...

All Angles List...

All Torsions List...

VTSNoOW CEIl aXes
More Info ~ =

[ 11abel atoms

Contacts

Centroids

Planes

Symmetry

Torsions

All Angles

All Torsions

Formula

Compound Name

Synonym
Space Group
Cell Lengths
Cell Angles
Cell Volume

7

T
] T

V), 2, 000

C13 H12Cla Ng O3

4-Acetoamido-3-(1-acetyl-2-
robenzylidene)hydrazine)-1,2

P -1

a 11.372(9) b 10.272(5) ¢ 7.35
a 108.75(6) p 71.07(4) y 96.1¢
769.978

Z:2272"1

Show cell axes
D Label atoms

Show hydrogens [ | Depth cue

[ ] Z-Clipping

|

Current structure: AABHTZ

Stereo

Click and drag left mouse button to zoom in.

-

10000.0 1
9000.0 1
8000.0 1
7000.0 1

000.0 1

%uoo.u 1
4000.0 1
3000.0 1
2000.0 1

1000.0 1

0.0

10.0

Wavelength: 1.54056

iy
20.0

Save...

30.0
2 theta
29.952, -2040

Close

Save image...

o [}
@
&
e ® .
e
®
©
X
®
® Q
" a3
o
e @

40.0 50.0

hkl=112
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3D printing S

File Edit Selection Display Calculate CSD-Community CSD-System CSD-Materials CSD-Discovery CSD Python APl Help ° . ai L AR
@
v ’ i 1 ®
Open... Ctrl+O Clear Measurements @' £ @[] show Labels for All atoms with |Atom L3 ’ | J
Recent Files » Manage Styles... |3D Print v | Atom selections: v | Select by SMARTS s ° i\
b * b* | x- x+ y- y+ z z+ x90 x+90 y-90 y+90 z90 z+90 <« - f 2
Sketch Molecule... Ctil+k | Ak £ iR AR | z y Y : z ‘
k]
®
Auto Edit Structure on Load Yy 4
Save As... Ctrl+S X
POV-Ray Image... . . / \
Print in 3D Simple interface toset up file @,
- o production + 3D print style
@ 3D Printing
File Format | WVRML (colour) ~
Scale (mm/A) ‘10.0 = ‘ Qutput Size (mm):

D Generate Support Framework
Plinth Thickness (&) 0.8

Column Radius (&) 0.4

Display @ g X
Pay Settings

Output Directory Jocuments/Education| | ~Browse... P. A. Wood, A. A. Sarjeant, et al., CrystEngComm, 2017, 19, 690-698 ( ( I )(




High-resolution images
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Generating high quality images G

= < e e N . 0°
Width (pixels)  |4000 | Height (pixels) . - S
Material Properties ‘Standard Mercury " File Format PNG ~ ) . =
Background ‘As Mercury " Custom Color I:l | e > p O\/_ Ray | m a g e

|:| Generate Animation Frames

File Edit Selection Display ¢~ @y Os Change Resolution

Dpen"_ Ctrl+ O Number of Frames 30 '
. Width = 4000 ¢
Recent Files b q
rovew. | | Reder ][ Gose Height = 3000
Save As... Ctrl+S Preview

POV-Ray Image...

Change ‘Material
Press Preview to generate image... . y { <
Print in 3D... Properties to ‘Metallic

Settings

POV-Ray Executable }ovray—S.7.I}.I}fbinfpvengine.exe|
Qutput Directory |C:f Users/ward |

In order to run concurrent rendering or generate preview images

whilst a render is running, it is necessary to enable multiple p reSS : D re\/| e\/\/’

instances of POV-Ray. To set this uncheck the "Keep Single

Exit Ctrl+Q

Set ‘Background’ to
Transparent’

Instance” option in the "Options" menu within the POV-Ray user
interface.




Previewing and rendering an image

Width (pixels) 14000

Material Properties Metallic ~ | File Format PNG

Background Transparent ~ | Custom Color
D Generate Animation Frames
Rotate around X W z
Number of Frames |30
Preview Render Close

Preview

Press Preview to generate image...

| Height (pixels) 3000

-

Width (pixels) 4000

Height (pixels)

Material Properties Metallic

Background Transparent

D Generate Animation Frames

Rotate around X Wy Z

Number of Frames 30

Preview

Preview

~ | File Format

~  Custom Color

Render

3000

PNG

Close
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A few more tips & tricks
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CSD Refcode:
NATJOH

Measure distances

0 NATJIOH (P21/n) - Mercury — |
File Edit Selection Display Calculate CSD-Community CSD-System CSD-Materials CSD-Discovery CSD Python APl Help
Picking Mode |Pi|:k Atoms ha ‘ Clear Measurements @ p @? [] Show Labels for All atoms with |Atom Label
Style: Capped "iCk Atoms Manage Styles... |Cards v | Atom selections: v Select by SMARTS:|[]
Lasso Atoms
[ ] Animate Expand Contacts ¢k X- X+ y- y+ z- z+ %90 x+90 y-90 y+90 z90 z+90 < - 4 1T zoom- Zzoom+

Toggle Labels
[ Move Labels
‘Measure Distances

Measure Angles

Measure Torsions

Reveal Symmetry-Generated Mlecules

Measure
Clear Measurements

Packing

Selection
Styles
Colours
Labels

Show/Hide

Contacts
Picking Mode
View

Rotation Centre

Mew

Draw Backdrop

Display Options...

Measure Distances
Measure Angles
Measure Torsions
Default Picking Mode

Clear Measurements




Adding, moving and sizing labels e

®
° 4 ® L
@ ADECIWO1 (P21/c) - Mercury — O X v
L
File FEdit Selection Display Calculate CSD-Community CSD-System CSD-Materials CSD-Discovery CSD Python APl Help ® »
Picking Mode: Move Labels v | Clear Measurements @Q @} Show Labels for Non C,H v ]ith Stereochemistry ~ ® » T
Style; Ball and Stick  Colour: by Element v Manage Styles... Cards ~ - Atom selections: ~ | Select by SMARTS: [c] | X a
0 ADECIWO1 (P21/c) - Mercury — O X - P R
File Edit Selection Display Calculate CSD-Community CSD-System CSD-Materials CSD-Discovery CSD Python APl Help v
Picking Mode: Move L: Styles L4 1 Clear Measurements IE Q Q} Show Labels for Non C,H ~ with | Stereochemistry b < e
Style: Ball and Stick *~ Labels / Atoms... rds v Atom selections: v |~ Select by SMARTS: [c] | C S D RefCO d e: A D E C | \/\/O-l
[ ] Animate.. C Colours ’ Centroids... y+ z- z+ x90 x+90 y-90 y+90 z90 z+90 ¢ - + T zoom- zoom+ i ®

Show/Hide ’ Planes...

More Information Label all
Symmetry Elements... Clear all labels
Voids... Reset label positions
Voids (Experimental)... Label colour...

Display Options... Label size...

Manage Styles...

View along
Dial box...

Splash screen

Toolbars

CCDC



Labelling chiral molecules

@ RERXIV (P212121) - Mercury — O X

File Edit Selection Display Calculate CSD-Community CSD-System CSD-Materials CSD-Discovery CSD Python APl Help

Picking Mode: |Pick Atoms ~ | Clear Measurements @g@ Eﬁ} IShow Labels for Stereocentres ~ with | Stereochemistry ~

Style: Ball and Stick ~ Colour: by Element ~ Manage Styles... |Cards ~ |- Atom selections: ~ | Select by SMARTS:‘[C]

D Animate... Default view: b ~ a b c a* b* * X- X+ ¥y y+ 7z Z+ X090 x+90 y-90 y+90 z-90 z+90 < - | T zoom- Zoom+
Structure Navigator F X
RERXIV Find
Crystal Structures Space: ™

reiv. 221, | CSD Refcode:
RERXIW Pnma RERX'\/

RERXIX C2/c
RERXIY P-1
RERXOEB Pcmin
RERXOC P21/c

Y
L4 >
<< >
Tree View
[ ] Multiple Structures
Structures...
Structure Navigator Searches
Graph Sets g X

No araph sets found ( ( | > <



